سخت افزار يا Hardware
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        سخت افزار كامپيوتر به تمامي وسايل و امكانات و قطعاتي كه قابل لمس بوده و عملا" قابل ديدن ،تغيير دادن و تعمير و تعويض نمودن ميباشند (مانند مانيتور، case(جعبه كامپيوتر ) ،صفحه كليد، ماوس، پرينتر،اسكنر و ابزارهاي دروني يا جانبي آن) اتلاق می گردد. كامپيوتر ساده اي كه ما معمولا  با آن سر و كار داريم داراي سه وسيله اصلي زير ميباشد كه بايد اطلاعاتي از آنها داشته باشيم:   

الف)مانيتور (Monitor)

        وسيله اي شبيه تلوِيزيون در اندازه هاي مختلف ولي با حساسيت خاصي جهت نمايش داده ها و تصوير ( بر مقياس پيكسل يا dpi). اين وسيله در قسمت عقب داري دو سيم رابط ميباشد كه يكي از آنها(متصل و ثابت مخصوص انتقال داده ها است) به پرتي (درگاه ورودي)  كه در پشت Case(جعبه كامپيوتر) تعبيه شده است متصل ميشود و ديگري كه سيم برق مي باشد به قسمتي  كه در   پشت Case مخصوص آن و در كنار سيم برق خود دستگاه است وصل شود. در قسمت جلو و زير صفحه نمايش كليد روشن و خاموش قرار دارد (سعي كنيد كه هميشه به حالت روشن باشد و مانيتور نيز همزمان با روشن شدن كامپيوتر روشن شود) و در سمت چپ يا پاييني مانيتور دكمه هاي تنظيم كيفيت نمايش، بزرگي، كوچكي و رنگ صفحه نمايش تصوير قرار دارد.   

ب) ماوس يا موشواره (Mouse)

        برنامه هاي امروزي بيشتر سعي مي نمايند طوري طراحي شوند كه بيشتر قابليت اجرا با ماوس را داشته باشند.چرا كه هم كار با آن ساده است و هم فراگيري و سرعت عمل آن مناسب است. 

        ماوس وسيله اي جهت اجرا و بکارگيری برنامه ها بخصوص در ويندوز و اينترنت كه داراي 2 كليد اصلی( كليد سومی که در وسط يا بغل بعضي از ماوسها قرار دارد در برنامه هاي خاصی بكار مي  رود) مي باشد.به کمک سيمي به كامپيوتر كه نشانگري (pointer or cursor ) را در صفحه مانيتور حركت و هدايت مي نمايد وصل است.اين نشانگر با حركت ماوس در سطح صافي (توپی كوچكي در زير ماوس است كه حساس بوده و نشانگر را حركت مي دهد.) در روي صفحه حركت مي كند و هر كجا باشد با توجه به نياز با ضربه (كليك كردن دكمه سمت راست يا چپ) عمل نموده و كار را پيش مي برد. 

كليد سمت راست جهت يكسري از برنامه هاي سيستمي (كپي،برش،حذف،انتخاب،ذخيره،تغييرات و…..)بكار مي رود. 

كليد سمت چپ كه مهمترين اعمال را انجام مي دهد چهار عمل زير را به عهده دارد. 

1)click : اگر روي فايل يا كلمه مورد نظر باشيم با يك بار فشار دادن كليد سمت چپ مي توانيم آنرا جهت اعمال كارهاي ديگر (مورد نظر ) انتخاب نمائيم كه رنگ آن آبي يا سياه مي شود. 

تذکر مهم: 
تا شما فايل يا مطلبي را انتخاب ننماييد نمي توانيد روي آن كاري انجام دهيد. ضمنا" يك بار كليك نمودن برنامه هاي start و يا internet را اجرا مي كند. 

2)double click : دو بار فشار دادن سريع کلید سمت چپ جهت اجراي (يا باز نمودن ) برنامه ها در ويندوز به كار مي رود. 

تذکر مهم: 
حتما" دو بار كليك متوالي،سريع و پشت سر هم باشند. 

3)click and drag: شما مي توانيد با كليك كردن و نگهداشتن كليد در پائين، (بدون رها کردن کليد) پنجره ها را بزرگ و كوچك و يا جا بجا نماييد. 

4)click and drop:شمامي توانيد فايلي يا متني را كليك كرده و با نگهداشتن كليد آنرا در جاي ديگري (جهت کپي يا حذف) بياندازيد. 

تذکر :اين چهار عمل در برنامه های خاص مانند برنامه نوشتاری word 97 کار خاص خود را انجام می دهند که تقريبا" شبيه اعمال بالا . است 

 

ب)صفحه كليد (Keyboard)

        وسيله اي است مانند دستگاه تايپ ،اين وسيله علاوه بر كاربردي كه در برنامه هاي نوشتاري جهت تايپ اعداد و ارقام و حروف بكار ميرود در برنامه هاي مختلف كارها و وظايف ديگري نيز به عهده ميگيرد. 
يك صفحه كليد استاندارد و معمولي داراي 101 يا 102 كليد ميباشد كه معمولا" در چهار يا پنج قسمت مجزا بر روي صفحه كليد پراكنده مي باشند.   

A)كليدهاي ارقامي( Number keys يا Numeric keys):

        مجموعه 17 كليد سمت راست كه روي آنها اعداد و ارقام و چهار علامت اصلي رياضي ميباشد (در صورتي كه بطور متناوب با اعمال رياضي و ارقام كار داريد كليد(Num Luck) رامي فشاريد تا چراغ(Num Luck) كه در بالاي همين قسمت صفحه كليد ميباشد روشن شود و اين قسمت كليدها  فعال شوند و مانند يك ماشين حساب با آن كار نماييد .كليدهاي روي آن شامل: 

1)ارقام صفر تا نه 

2)علامت (-) منها،(×)ضرب،(/)تقسيم،(+) جمع و (.) نشانگر مميز مي باشند. 

3 )كليدNum Luck كه جهت فعال نمودن كليدهاي ارقامي است ( در بالاي صفحه چراغي وجود دارد که روشن و خاموش بودن آن  نشانگر فعال يا غير فعال بودن اين كليدها  مي باشد.) 

4)كليد Enter كه بعد از تايپ اعمالي (داده ها يا اطلاعاتی)جهت اعمال و آمادگي براي دادن اعمال بعدي رفتن به مرحله بعدی و زدن مجّدد آن جهت دريافت حاصل كار(به نوعي معادل علامت مساوي(=) است ) بکار می رود. 

تمرين: برنامه ماشين حساب calculator دستگاه را اجرا نموده و مطالب بالا را مشاهده و تمرين نماييد.

start>programs>accessories>calculator 

تذكر مهم:
        بعضي از كليدهاي بالا در صورتي كه كليدNum Luck فعال نباشد اعمال ديگري كه روي آنها مشخص شده است را انجام مي دهند . مانند كاربرد كليد هاي ويرايشي زير خواهند شد.(بالا و پايين ،سمت چپ و راست بردن  Cursor (نشانگر) در صفحه، و خط در متنها و جاهاي ديگر) 

B)كليدهاي ويرايشي(Text keys يا Edit keys)

        مجموعه 13 كليد ويرايش متنها كه در رديف دوم بعد از كليدهاي ارقامي در وسط صفحه قرار دارند.كليدهاي مخصوص ويرايش و كنترل صفحه متن ميباشد و عبارتند از: 

تمرين : جهت مشاهده و كار عملي با كليدهاي ويرايش ، متني را ازMy documents باز نموده و يا برنامه نوشتاري WordPad را اجرا نماييد
Start>programs>accessories>WordPad

1)چهار كليد جهت نما (arrow keys) كه جهت بالا وپايين،سمت  راست و چپ بردن  نشانگر      ( pointer) در متن (در حالت عادي به اندازه يك كاراكتر ( حرف ) به سمت چپ و راست و يا يك خط   به بالا و پائين جابجا مي نمايند ولي بهمراه (فشردن) كليد   ctrl كه در روي صفحه اصلي و حروف قرار دارد شامل پرش كلمه ، پاراگراف  و صفحه نمايشی مي شوند.) 

كليدهاي اشاره گر(arrow keys )  شامل موارد و حالتهای زير هستند: 

a) كليد فلش بالابر در متن اشاره گر را يك خط بالا ميآورد. 

b) كليد فلش پايين رو در متن اشاره گر را يك خط پايين ميآورد. 

c) كليد فلش راست بر در متن اشاره گر را يك حرف به سمت راست ميآورد. 

d) كليد فلش چپ بر در متن اشاره گر را يك حرف به سمت چپ ميآورد. 

 و اما در قسمت بالای کليدهای اشاره ای (arrow keys ) کليد های زير قرار دارند. 

2)كليد page up كه صفحه متن را  به اندازه يك صفحه نمايشی يا مانيتور به طرف بالاميبرد. 

3) كليد page down كه صفحه متن را  به اندازه يك صفحه نمايشی  يا مانيتور به طرف  پايين می آورد. 

4)كليدhome  نشانگر را به اول همان خط ميبرد. 

5) كليدend نشانگر را به انتهاي همان خط ميبرد. 

6)كليد delete با يك بار زدن آن يك حرف سمت راست(انگليسي)  نشانگر را حذف مينماييد (يا كلمه  يا جمله انتخاب شده را.) 

7)كليد  insert  جهت قرار دادن كلمه اي يا حرفي (كاراكتري) به جاي حرف يا كلمه ديگري كه انتخاب  نموده ايم. 

نکته مهم: 
اين دكمه ها بهمراه كليد Ctrl وظايف ديگري به عهده ميگيرند.از جمله: 

1)كليد page up به همراه كليد Ctrl  صفحه متن را  به اندازه يك صفحه چاپي به طرف بالاميبرد. 

2) كليد page down به همراه  كليد ctrl صفحه متن را  به اندازه يك صفحه چاپي به طرف  پايين ميبرد. 

3)كليدhome   به همراه كليد Ctrl نشانگر را به اول كل  متن ميبرد. 

4) كليد end به همراه كليد Ctrl  نشانگر را به انتهاي كل متن ميبرد. 

5) كليد فلش راست  و  چپ بر در متن بهمراه Ctrl اشاره گر را يك كلمه به سمت راست و يا چپ ميآورد. 

6) كليد فلش بالا و پائين بر در متن بهمراه Ctrl اشاره گر را يك پاراگراف به سمت بالا يا پائين ميآورد. 

و همچنين چند كليد ديگر(7-كليد pause break و8-scroll lock و9-print screen sysRq ) در روی آنها قرار دارد. 
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روي case هر كامپيوتر دو كليد مهم قرار دارد كه يكي از آنها دكمه power مىباشد كه جهت روشن و خاموش نمودن دستگاه استفاده مىشود ( On روشن و Off خاموش ) و دكمه ديگر دكمه Reset مىباشد هنگاميكه دستگاه روشن بوده و بنا به ضرورت( هنگاميكه برنامهhang يا اصطلاحا" قفل مىنمايد ،برنامه جديدي نصب مىشود كه نياز به راه اندازي مجدد دارد ويا سيستم كنده شده و مشكل خاصي دارد كه شايد با راه اندازى مجدد درست شود) بايد مجددا" راه اندازي گردد استفاده مىشود و دستگاه را دوباره بدون خاموش كردن بالا آورده و راه اندازي مىكند كه اصطلاحا" boot كردن مىگويند. 

هنگامي كه شما دكمه power را فشار داده و كامپيوتر را روشن مي كنيد سيستم اصطلاحا" boot شده و بالا مي آيد و امكان دارد جهت ورود به برنامه windows از شما نام كاربر user name و رمز ورود يا password را كه مخصوص هر كسي كه مي خواهد وارد برنامه شود بخواهد. اگر شما نام و پسورد جداگانه داريد نوشته و با كليد سمت چپ ماوس در روي دكمهok كليك كرده يا از روي كليدها دكمه Enter را فشار دهيد ولي اگر به دلايل مختلف اجازه ورود نتوانستيد بگيرد ميتوانيد با كليك روي دكمه cancel وارد سيستم شود و از برنامه هاي عمومي آن دستگاه استفاده نماييد.

صفحه اي كه ظاهر مي شود اصطلاحا" Desktop يا ميز كار نام دارد و روي آن شكلهايي كه icon يا شمايل ناميده ميشوند قرار دارد و نشانگر (يا ميانبر= shortcut ) برنامه هاي مختلف مي باشند و با دو بار كليك دكمه سمت چپ ماوس پنجره آنها باز شده و شما ميتوانيد از آنها استفاده نماييد.

در زير ميز كار نواري قرار دارد كه اصطلاحا" نوار وظيف يا taskbar ناميده مي شود كه علاوه بر داشتن icon هاي خاص،نمايش دهنده نام برنامه هاي فعال روي ميز كار ميباشند. و مهمتر از همه دكمه start در سمت چپ قسمت پايين روى آن قرار دارد و اگر روي آن كليك كنيد مي توانيد به سراغ برنامه هاي موجود در كامپيوترتان رفته و آنها را اجرا نماييد كه معمولا" شامل امكانات زير نيز ميباشد كه بطور مفصل بعدا" در جزواتي ديگر تك تك آنها را آموزش و بررسى خواهيم كرد.

1) ...Shut down : كه شما براي بستن دستگاه و خروج از كامپيوتر و كارهاى ديگر از آن استفاده خواهيد كرد.

2) ...Log off : از برنامه هاي شما خارج شده و آنها را بسته و اجازه مي دهد كاربر ديگر با وارد نمودن نام و رمز ورود وارد برنامه هاي خودش شود.

3) ...Run : در اين قسمت با نوشتن نام و مسير برنامه يا يافتن آن از طريق browse شما مي توانيد برنامه را سريعا" اجرا نماييد.

4) Help : برنامه راهنماي (كمك ) انگليسي جهت آموزش و رفع اشكال انواع برنامه هاي windows را باز مي كند.

5) Find  :كه به شما اجازه پيدا كردن انواع برنامه ها ،فايلها،و فولدرها را در كامپيوترتان مي دهد و همچنين امكانات خاص ديگري در اختيار شما قرار مي دهد.

6) Setting : امكانات تنظيم انواع دستگاههاي سخت افزاري ،نرم افزاري و برنامه هاي جانبي را ميدهد.

7) Documents : شما از طريق اين بخش مي توانيد سريعا" به برنامه My Documents رفته و همچنين در اين قسمت حدود 15 برنامه اسناد ، مدارك و برنامه هاي كاربردى كه اخيرا" اجرا نموده ايد در حافظه آن قرار دارد و شما سريعا" مي توانيد از آنها استفاده نماييد.

8) Favorites : برنامه هاي مورد علاقه اينترنتي كه در حافظه دارد و يا شما اضافه نمويده ايد را نشان مي دهد.

9) Programs : شما را وارد برنامه هاي نصب شده روي كامپيوترتان مي نمايد كه از جمله آنها برنامه Accessories مي باشد.كه خود شامل برنامه هاي متنوعي از جمله Internet tools و Communication جهت تنظيم و وارد شدن به برنامه هاي اينترنت مي باشد. Entertainment كه يكسري وسايل و امكانات تفريحي از جمله cd و ضبط و دستگاه تماشاي فيلم(Media Player ) از طريق كامپيوتر مي باشد. System tools يكسري برنامه هاي سيستمي و تنظيم و چك نمودن دستگاه را در اختيار شما قرار مي دهد. Address book امكان ثبت مشخصات ،تلفن و آدرس مي باشد و مانند يك دفتر تلفن است. Imaging جهت مشاهده و تنظيم و كار روي تصاوير و عكسها است. Calculator شامل ماشين حساب معمولي و همچنين علمي مي باشد. Notepad برنامه نوشتاري ساده اي جهت ياداشت گذاشتن است. WordPad برنامه نسبتا" كاملي جهت نوشتن مدارك،نامه ها، متون و جزوات مي باشد. Paint جهت رسم نقاشي مي باشد.

قسمتهاي مختلف يک پنجره در ويندوز98
هنگام اجراي اكثر برنامه ها معمولا" يك پنجره باز مي شود كه شما بايد توانايى كنترل و نحوه استفاده نمودن آن پنجره را بايد داشته باشد و 90% كار پنجره ها شبيه هم مي باشد و اگر شما نحوه كار با يك پنجره را خوب بدانيد مي توانيد از پنجره هاي ديگر نيز به راحتي استفاده نماييد. و ما براي نمونه پنجره My Documents يا اسناد و مدارك را در اينجا و پنجره Internet explorer را جهت آموزش اينترت تشريح مي كنيم و در قسمتهاى بعد انشا الله بقيه برنامه ها را بطور مفصل ارائه خواهيم داد.

با دو بار كليك كردن روي Icon برنامه My Documents (ميانبر زرد رنگ شبيه پاكت نامه كه روى ميز كار قرار دارد) پنجره آن باز مي شود. اكثر پنجره ها داراي هفت قسمت زير مي باشند.

1) Title bar يا نوار عنوان برنامه
2) Menu bar نوار فهرست و ابزار مورد نياز برنامه
3) Tool bar يا نوار ابزار كار و مورد استفاده زياد جهت راحتى انجام كارها
4) Address bar يا نوار آدرس و مسير برنامه
5) Display يا صفحه نمايش اطلاعات ، انجام عمليات و محتويات برنامه
6) Status bar يا نوار وضعيت يا حالات
7) Scroll bar يا نوار گردش ( بالا و پايين نمودن محتويات پنجره)

در زير به توضيح تك تك آنها مي پردازيم:

1)Title bar

Title bar يا نوار عنوان كه در بالاي همه پنجرها كه معمولا" نيز به رنگ آبي مي باشد قرار دارد و عنوان برنامه اي كه در آن قرار داريم را نشان مي دهد.(در اين پنجره عنوان My Documents )

در سمت راست نوار عنوان سه جعبه (box ) كوچك ولي مهم جهت كنترل پنجره قرار دارد كه اگر اشاره گر را روي آنها نگهداريد نامشان به انگليسي پيدا مي شود و عبارتند از:

Minimize box 

 كه به شكل يك منها ( - ) بوده و درسمت چپ قرار دارد و اگر روي آن كليك نماييد پنجره شما كوچك شده و در روي نوار وظيفه يا Task bar مي نشيند و شما مي توانيد ميز كارتان را مشاهده نماييد و يا از برنامه هاي ديگرتان براحتي استفاده نماييد و درصورت نياز به آن بر نامه فقط كافي است يك بار روي اسم آن روي نوار وظيفه كليك نماييد و پنجره شما سريعا" باز مي شود. توجه شود كه Minimize پنجره شما را نبسته بلكه بطور فعال از جلو چشم در روي ميز كار خارج نموده و به روي نوار وظيفه مي برد.

  Maximize/Restore box 
 كه به شكل مربعي در وسط دو دكمه ديگر قرار دارد و به شما اين اجازه را مي دهد كه پنجره را كه معمولا" يك سوم صفحه نمايش است را به حداكثر رسانده و بتوانيد از پنجره نهايت استفاده را نماييد. و در صورت نياز با كليك مجدد روي آن صفحه را كوچكتر مىنمايد تا حدودي نيز شما علاوه بر اين پنجره به ميز كارتان نيز تسلط داشته باشيد.

تذكر:
·· شما در صورتي كه پنجره به حالت كوچك باشد مي توانيد با كليك روي بخش آبي رنگ نوار عنوان Title bar و نگهداشتن دكمه ماوس ( click and drag ) پنجره را روي ميز كار جابجا نماييد.

·· در حالتي كه پنجره كوچك مي باشد شما مي توانيد اشاره گر را به لبه هاي كناري پنجره نزديك نموده و هنگامي كه اشاره گر از حالت يك فلش سفيد به يك فلش سياه نازك دو طرفه در مي آيد دكمه ماوس را كليك نموده ، دكمه را نگه داشته و بكشيد تا بتوانيد پنجره را به اندازه دلخواه كوچك يا بزرگ نماييد وسپس دكمه را رها نماييد.

Close box 

كه به شكل يك ضربدر بوده و با كليك روي آن پنجره از فعاليت افتاده و بسته خواهد شد و براي اجراي مجدد آن دوباره به جايگاه اوليه آن برنامه رفته و آن را فعال نماييد.

2) Menu bar

Menu bar يا نوار فهرست كه خود شامل قسمتهاي مختلفي از جمله file, edit, view, go, favorites, و help برنامه مي باشد كه اين عنوانها در پنجره هاي مختلف شايد كم يا زياد نيز باشند.

در اين قسمت فهرست ابزار و وسايلي كه شما جهت انجام كار به آنها در اين برنامه نياز داريد در درون اينها قرار دارند كه با كليك روي هر كدام فهرستهاي گوناگون هر قسمت به صورت پرده كره كره اي افتاده و آويزان مي شود كه با رفتن روي هر يك از آنها ( اشاره گر را سر دهيد،كليك نكنيد ) در صورتي كه به رنگ سياه باشند و كليك روي آنها مي توانيد كار مورد نظر را اجرا نماييد.( اگر رنگ عمل مورد نظر خاكستري باشد بدين مفهوم است كه آن عمل در حال حاضر فعال نبوده و بايد شما عمل ديگري مثلا" چيزي را انتخاب نماييد تا آن عمل فعال و سياه رنگ شود).

تمامي اعمال و برنامه هايي كه شما در يك پنجره جهت انجام كار به آن نياز داريد در درون نوار فهرست پنجره قرار دارد ولي نترسيد نياز نيست به همه آنها مسلط باشيد و ابزاري كه براى انجام كارها نياز داريد و 90 الي 95% مورد نياز است بطور ملموس و همراه شكلهاي ساده از ميان تمامي اين ابزارها انتخاب شده و در زير نوار فهرست به عنوان نوار ابزار يا Tool bar قرار گرفته است و اگر شما به كار با آنها تسلط داشته باشيد به راحتي مي توانيد آن برنامه را به كار گيريد.

3) Tool bar

Tool bar يا نوار ابزار نشانگر ابزارهاي مورد نياز انتخابي از نوار فهرست مي باشند كه جهت سهولت انجام كار به صورت اشكالى گويا روي اين نوار قرار دارند و با كليك روي آنها كار مورد نظر انجام مي پذيرد.(در صورتي كه عمل مورد نظر فعال باشد سياه رنگ بوده و گرنه خاكستري (غير فعال) مي باشد.)

از جمله اين ابزارها مثلا" درMy Documents عبارتند از:

Back  برگشت به عقب
اگر شما درون اين پنجره شما وارد يكى از پوشه هاي دروني آن شويد مي توانيد با زدن دكمه back مجددا" به پنجره اولي برگرديد.

Forward   رفتن به جلو
 اگر از صفحه اي درون اين پنجره به عقب برگشته باشيد ميتوانيد با زدن forward مجددا" به صفحه قبلي برگرديد.

 Upرفتن به سطح بالا
 پنجره شما را تا desktop از قسمتها و بخشهاي مختلف drive ها با لا مي آورد.

Cut بريدن ،برداشتن و در حافظه نگهداشتن قسمت انتخابى  

موضوع يا پوشه و فايلها ي انتخاب شده شما را بريده و از اين پنجره و قسمت برداشته و در حافظه موقت كهclipboard ناميده مىشود نگهداري مي كند تادر جايگاه مورد نظر بچسبانيم ( paste ).

Copy  نسخه بردار يا كپي و در حافظه قرار دادن قسمت انتخاب شده 

 يك نسخه از موضوع يا پوشه و فايلها ي انتخاب شده شما را برداشته و در حافظه موقت كهclipboard ناميده مي شود نگهداري مي كند تادر جايگاه مورد نظر بچسبانيم ( paste ).

تذكر:
cut آن پوشه يا قسمت انتخاب شما را كلا" از آن قسمت بر مي دارد و به جاي ديگري انتقال مي دهد و لي copy به موضوع انتخاب شده كاري نداشته و آن را در جايگاه اوليه حفظ نموده و تنها نسخه اي(رونوشتي ) از آن را در حافظه جهت استفاده مجدد نگه مي دارد. ضمنا" فراموش نشود كه delete فايل يا فولدر انتخاب شده كلا" حذف كرده و در حافظه جهت استفاده نگه نمي دارد.

Paste   الصاق يا چسپاندن قسمت كپى شده يا بريده شده
 موضوع يا پوشه و فايلها يي كه شما كپي نموده و يا بريده ايد و در حافظه موقت مىباشد را در جايگاه مورد نظر مىچسباند.

Undo  خنثى نمودن عمل آخر در آن پنجره 

 كار آخري را كه انجام داده ايد را معكوس يا بي اثر كرده و به حالت اول بر مىگرداند.

Delete  حذف و برداشتن موضوع انتخابى از كامپيوتر 

 موضوع يا پوشه و فايلها ي انتخاب شده شما را كلا" حذف نموده و به سطل آشغال ( Recycle bin ) مي برد و يا كلا" از كامپپوتر حذف مىنمايد. 

Properties مشخصات و ويژگيهاى برنامه انتخابى
 اگر فايل يا فولدري را انتخاب نماييد و روي اين دكمه كليك كنيد مشخصات،آدرس، اندازه ونوع برنامه مورد نظر را نشان مي دهد.

View نمايش فايلها و فولدرها 

 نحوه نمايش فايلها و فولدرهاي درون پنجره را به صورت Large Icons (بزرگ) ، Small Icons (كوچك) ، List (فهرست) و details كه فايلها را با جزئيات تمام از قبيل نام، اندازه،نوع و تاريخ ايجاد يا تغيير را نيز نشان مىدهد.

4) Address bar

Address bar يا نوار آدرس كه محل و مسير قرار گرفتن فايل يا پوشه و پنجره باز شده را نشان مىدهد و شما براي فراخواني فايل يا پوشه مورد نظر ديگر مىتوانيد درون آدرس كليك كرده و آدرس مورد نظر را نوشته كليد Enter را بزنيد تا برنامه اجرا شود و يا روي فلش كوچكي كه در انتهاي سمت راست نوار آدرس قرار دارد كليك كنيد تا آدرسهاي بخشها و پارتيشنهاي مختلف كامپيوتر را مشاهده نماييد(Desktop, Floppy(a:) My Computer, C: , D: , E: , F:(cd rom) ,My Documents ,Network Neighborhood , Control panel ,Printer , Internet Explorer ) و درون آنها رفته و فايل مورد نظر را پيدا نماييد و آن را اجرا كنيد.

5) Display window

Display window كه همان صفحه اصلي و بزرگي است كه شما محتويات يك پنجره را درون آن مشاهدمكنيد و در صورت لزوم انتخاب و اجرا مىكنيد.

6) Status bar

Status bar يا نوار وضعيت كه در انتها و ته يك پنجره قرار دارد و وضعيت وموقيت ومحل فايلهاي انتخابي را نشان مىدهد.مثلا" اگر شما فايلي را انتخاب نماييد اندازه و سايز آن را در روي نوار وضعيت مشاهده خواهيد نمود.

7) Scroll bar

Scroll bar يا نوار گردش ( بالا و پايين نمودن محتويات پنجره) كه فقط درصفحاتي قابل مشاهده مىباشد كه محتويات آن صفحه زيادتر و بزرگتر از اندازه يك پنجره و صفحه نمايش مىباشد و شما جهت مشاهده بقيه محتويات و موضوعات آن صفحه با استفاده از Scroll barهاي عمودي يا افقي پنجره كه بصورت نواري نازك كه در دوسوي آن يك فلش قرار دار استفاده نماييد.( تذكر: براي اين امر مىتوانيد از دكمه هاي Text editing keys يا كليدهاي ويرايشي موجود روي صفحه كليد استفاده نماييد).

اگر شما روي فلشي كه روي Scroll bar قرار دارد يكبار كليك نماييد محتويات صفحه شما به اندازه يك خط بالا يا پايين مىشوند.و اگر اشاره گر در زير فلش جايي كه خالي است گذاشته و يكبار كليك نماييد محتويات صفحه شما به اندازه يك صفحه نمايشي (page up/down ) جابجا خواهد شد. و ضمنا" مىتوانيد روي دستگيره يا زبانه اي كه در بين دوفلش در وسط Scroll bar قرار دارد كليك نموده آنرا نگهداشته و به اندازه دلخواه بالا يا پايين ببرييد.

دقت شود كه تمامى مطالب بيان شده در خصوص پنجره My Documents در سا ير پنجره ها صادق بوده و عين آن عمل مىنمايد و فقط يكسرى از ابزارهاى مورد نياز هر برنامه با برنامه ديگر فرق دارد. 

شيوه هاى مختلف باز كردن پنجره مربوط به آيكون در ويندوز 98
در ويندوز 98 براى باز كردن پنجره مربوط به يك آيكون يا براي رفتن به داخل يك پوشه از روشهاي زير استفاده ميشود: 
     نكته:براي انتخاب يك آيكون كافيست يك بار دكمه چپ ماوس را روي آيكون مربوطه كليك كنيم. 

1. دو بار كليك دكمه چپ ماوس روي آيكون مورد نظر.
2. انتخاب آيكون مورد نظر به وسيله ماوس سپس فشردن كليد ENTER.
3. كليك راست ماوس روي آيكون مربوط و انتخاب دستور Open از كادر دستورات. 

شيوه هاي بازگشت به مراحل قبلا طي شده در ويندوز 98
1. كليك چپ ماوس روي ابزار Up  در نوار ابزار.
2. كليك چپ ماوس روي ابزار Back در نوار ابزار. 

     نكته: براي مراحل طي شده به سمت جلو از ابزار Forward روي نوار ابزار استفاده ميكنيم. 

راه هاي به حداكثر رساندن(بزرگ نمودن) اندازه يك پنجره در ويندوز 98
1. كليك چپ روي دكمه سمت راست بالاي هر پنجره (جعبه مربع شکل ما بين × و -).
2. دو بار كليك روي خط عنوان پنجره اي كه اندازه آن به حد اكثر نرسيده است.
3. يك بار كليك راست روي منوي كنترل هر پنجره سپس انتخاب دستور Maximize. 

راه هاي به حداقل رساندن اندازه يك پنجره در ويندوز 98
1.  كليك چپ روي دكمه Minimize (علامت منها ) در سمت راست بالاي هر پنجره.
2.  يك بار كليك راست روي منوي كنترل هر پنجره سپس انتخاب دستور Minimize 

راه هاي بازگرداندن اندازه( يك پنجره به حد اكثر رسانده شده) به حالت اول در ويندوز98
1.  كليك چپ روي دكمه Restore (جعبه مربع شكل ما بين× و -)  در سمت راست بالاي هر پنجره به حداکثر رسيده شده.
2.  دو بار كليك روي خط عنوان پنجره اي كه اندازه آن به حداكثر رسيده است.
3.  يك بار كليك راست روي منوي كنترل هر پنجره سپس انتخاب دستور Restore از انتخاب دستورات. 

راه هاي ساختن يك پوشه جديد در ويندوز 98
1.  صدور فرمانFolder از زير فهرست New در منوي File . 

File>New>Folder

2.  كليك راست ماوس ( روي ناحيه اي خالي از فضاي هر پنجره يا ناحيه اي خالي از ميان بر) زده سپس صدور فرمان  New از فهرست دستورات و در نهايت انتخاب گزينه Folder . 

    نكته: پس از اينكه پوشه جديد ساخته شد ويندوز بطور پيش فرض نام آن راNew Folder قرار ميدهد. براي اينكه نام پوشه را تغيير دهيم كافيست بجاي گزينه مزبور نام انتخابي خود را بنويسيم. 

راههاي تغيير نام يك پوشه يا فايل در ويندوز 98
1. صدور دستورRename از منوي File . 

File > Rename

2. كليك راست روي مورد انتخابي و صدور فرمان Rename از فهرست دستورات.
3.  پس از اينكه پوشه يا فايل مورد نظر را انتخاب كرديم يك بار ديگر (نه بطور سريع و متوالي ) روي آن کليک چپ نماييم تا قسمت نام آن پوشه جهت درج نام جديد فعال شود. 

راههاي حذف يك پوشه يا فايل در ويندوز 98
پس از اينكه پوشه يا فايل مورد نظر را انتخاب كرديم براي انجام عمل حذف به يكي از روشهاي زير عمل ميكنيم. 

1. صدور فرمانDelete  از منوي فايل. 

File> Delete

2. كليك چپ روي ابزار Delete در نوار ابزار.
3. كليك راست روي مورد انتخابي و صدور فرمان Delete از كادر مربوطه.
4.  فشردن دكمه چپ ماوس روي مورد انتخابي و نگهداشتن دكمه چپ و كشيدن ماوس تا اينكه روي سطل بازيافت قرار گيرد.Drag and drop
5.  فشردن كليد Delete از طريق صفحه كليد.
شيوه هاي مختلف صدور فرمان Copy( کپی نمودن از فا يلی)

1. صدور فرمان  copyاز منوي Edit . 

Edit> Copy

2. كليك چپ روي ابزار copy در نوار ابزار.
3.  كليك راست روي مورد انتخابي سپس صدور فرمان Copy از كادر دستورات.
4.  فشردن كليد تركيبي. 

شيوه هاي مختلف صدور فرمانCut (بريدن و برداشتن فا يلی)

1.  صدور فرمان cut از منوى Edit . 

Edit > Cut

2.  كليك چپ روي ابزار Cut در نوار ابزار.
3.  كليك راست روى مورد انتخابي سپس صدور فرمان Cut  از كادر دستورات.
4.  فشردن كليد تركيبي Ctrl + X. 

شيوه هاي مختلف صدور فرمان paste ( چسباندن فا يلی)

1.  صدور فرمان paste از منوي Edit . 

Edit>paste

2. كليك چپ روي ابزار paste در نوار ابزار.
3.  كليك راست روي مورد انتخابي سپس صدور فرمان paste از كادر دستورات.
4.  فشردن كليد تركيبي Ctrl+V . 

شيوه هاي مختلف صدور فرمان Undo(حذف و بی اثر نمودن آخرين عمل انجام شده در پنجره ای که هنوز فعال است و بسته نشده)

توضيح: عمل Undo يكي از بهترين دستورات ويندوز 98 و برنامه هاي اجرا شونده تحت آ ن ميباشد و بدين صورت عمل ميكند كه آخرين دستور قبلي را لغو ميكند.

1.  صدور دستورUndo از منوي Edit . 

Edit>undo

2.  كليك چپ روي ابزار Undo در نوار ابزار.
3.  فشردن كليد تركيبي Ctrl+Z بعد از آخرين عمل. 

در ويندوز 98 براي اينكه از روي يك فايل يا يك پوشه نسخه جديدي (Copy)ايجاد كنيم بايد مراحل زير را انجام دهيم.

نحوه انجام عمل copy

1.  انتخاب پوشه يا فايل مورد نظر.
2.  صدور فرمان copy . صدور فرمان كپى مانند حذف ميباشد فقط بجاي delete از copy استفاده ميشود
3.  انتخاب مقصد عمل Copy .
4.  صدور فرمانPaste يا چسباندن.

صدور فرمان چسباندن نيز مانند سه روش اولdelete است.

تذکر: اين مراحل به جای ماوس با کليدها نيز به صورت زير قابل انجام است 

1) ctrl + c => copy  then  2) ctrl + v => paste

روش هاي انتخاب آيكونها (جهتcut, copy,ياdelete نمودن چند پوشه با هم)يا انتخاب غير متوالي
براي انتخاب غير متوالي چند آيكون مراحل زير را انجام ميدهيم.

1.  انتخاب مورد اول (كه ممكن است يك پوشه يا يك فايل يا يك نماد باشد.)
2. نگه داشتن كليدCtrl و انتخاب موارد بعدي با استفاده از كليك دكمه سمت چپ ماوس.

نكته: با نگه داشتن كليد Ctrl و كليك روي آيكونها ميتوان موردي را به موارد انتخابي خود اضافه كنيم يا با كليك مجدد روي انتخاب قبلي خود آن را از   از موارد انتخابي خود كم كنيم. 

انتخاب متوالي
براي انتخاب متوالي چند آيكون به روش زير عمل ميكنيم :

1.  انتخاب مورد اول.
2.  نگه داشتن كليدshift و انتخاب مورد آخر.

نكته : در حالت فوق ويندوز تمامي آيكونهاي بين مورد اول و آخر را انتخاب ميكند.

انتخاب تمامي آيكونهاي داخل يك پنجره
براي انتخاب تمامي آيكونهاي داخل يك پنجره به روشهاي زير ميتوان عمل كرد:

روش اول: صدور دستورSelect All ا از منوي Edit .

روش دوم: با استفاده از كليد تركيبي Ctrl+A عمل انتخاب را انجام ميدهيم.

معكوس نمودن انتخابهاي انجام شده
براي معكوس نمودن موارد انتخابي به روش زير عمل ميكنيم :

1.  انتخاب مواردي كه نمي خواهيم جز’ انتخاب باشند.
2.  صدور فرمان Invert Selection از منوي Edit .

شيوه هاي مختلف آرايش پنجره هاي باز شده
ويندوز با سه روش پنجره هاي باز شده را روي ميز كار آرايش ميدهد كه عبارتند از:

Cascade Windows : پنجره را به صورت آبشاري ( روي هم) مرتب ميكند.

Tile Windows Horizontally : پنجره ها را به صورت افقي و كنار هم مرتب ميكند .

Tile Windows Vertically : پنجره ها را به صورت عمودي و كنار هم مرتب ميكند.

    مراحل انجام عمل:
1.  كليك راست روي نوار وظيفه ( Taskbar ) (نواري است كه پايين ميز كار(desktop ) قرار دارد و كليد (start ) روي آن در سمت چپ قرار دارد.)
2.  انتخاب يكي از سه مورد فوق از كادر دستورات ظاهر شده.

گزينه هاي مربوط به مشخصات فايلها و پوشه ها (Properties)

هر فايل يا پوشه در ويندوز 98 دارا ى خصوصياتي است كه اين خصوصيات توسط مراحل ذيل قابل رويت ميشود: 

1. كليك راست روي پوشه يا فايل مورد نظر
2. انتخاب دستور Properties از كادر دستورات 

در پنجره ظاهر شده نام پوشه يا فايل ، اندا زه فايل يا پوشه محل قرار گرفتن فايل يا پوشه و اطلاعات ديگري مربوط به پوشه يا فايل نشان داده شده است . در قسمت پايين پنجره قسمتي به نام attributes ( صفات) مربوط به فايل يا پوشه قرار دارد كه صفات مربوط به فايل يا پوشه مورد نظر را نشان ميدهد. 

از بين چهار صفت ذكر شده براي هر فايل يا پوشه ، هر كدام از گزينه ها علامت خورده باشد بدين معني است كه فايل يا پوشه مورد نظر داراي آن صفت است . براي انتساب صفتي به فايل يا پوشه اي كافيست روي گزينه مزبور يك بار كليك چپ كنيم همچنين براي غير فعال كردن صفتي كافيست يك بار ديگر روي گزينه مزبور كليك چپ كنيم تا از حال انتخاب خارج شود. 

صفت فايلها ( Attribute )

هر فايل ممكن است از لحاظ چگونگي ذخيره بر روي ديسك داراي يك يا چند صفت از صفات زير باشد: 

Read Only فقط خواندني): فايلهايي كه فقط قابل خواندن يا اجرا بوده و بر روي آنها كپي چيزي نشده و قابل پاك شدن نميباشد. 

Archiveآرشيو) : حالت عادي ذخيره فايلها بر روي ديسك است.

Hidden پنهان) : فايلهايي كه هنگام گرفتن ليست اسامي فايلها، اسم آنها در ليست نميآيد .اين فايلها قابل پاك شدن و كپي شدن نبوده ولي به اجرا در ميآيند.

Systemسيستم): فايلهايي كه صرفا” حين راه اندازي كامپيوتر قابل اجرا ميباشند و مانند فايلهاي پنهان اسم آنها در ليست نميآيد.

توضيح دستور Folder Option در منوي View :

ويندوز 98 در حالت عادي تمامي فايلها و پوشه ها را به كاربر نشان ميدهد ، ميتوان فايلهايي را كه صفت System يا Hidden دارند از ديد كار بر پنهان نمود. بدين منظور بايد مراحل ذيل را انجام داد:

1.  انتخاب منوي View
2.  صدور فرمان Folder Option
3.  انتخاب تب View
4.  انتخاب يكي از دو گزينه زير:

Do not show hidden or system files : فايلها يا پوشه هاي داراي صفت مخفي يا سيستم را نشان ندهد .

Do not show hidden files : فايلها يا پوشه هاي داراي صفت مخفي را نشان ندهد.

انتخاب گزينه Show All Files باعث نشان داده شدن تمام فايلها ميشود.

مراحل خالي نمودن محتويات منوى اسناد(Documents )

روش اول
1.  كليك راست روي نوار وظيفه .
2. انتخاب دستور Properties از كادر دستورات.
3.  انتخاب تب START Menu از پنجره ظاهر شده.
4.  كليك چپ روي دكمه Clear در پنجره ظاهر شده.
5.     كليك روي دكمه OK .

  روش دوم
1. باز كردن منوي Start .
2.  باز كردن منوي Setting و انتخاب گزينه Taskbar & Start Men.
3.  انتخاب تب Start Menu از پنجره ظاهر شده.
4.  كليك چپ روي دكمه Clear در پنجره ظاهر شده.
5.  كليك روي دكمه OK .

راه هاي دستيابي به پنجره مركز كنترل Control Panel

روش اول
باز كردن پنجره My Computer  سپس باز كردن پنجره آيكون Control Panel 

My Computer > Control Panel 

روش دوم
باز كردن منوي start و انتخاب منوى setting و سپس انتخاب گزينه Control Panel 

Start > setting > Control  panel

شيوه هاي مختلف نمايش آيكونهادر پنجره ها
ويندوز 98 ميتواند آيكونها را با نمايشهاي مختلفي در هر پنجره ويندوز نشان دهد كه عبارتند از:

Large Icons: در اين روش آيكونها در شكل بزرگ شده خود ظاهر ميشوند.

Small Icons: در اين روش آيكونها در شكل كوچك شده خود ظاهر ميشوند.

List:در اين روش آيكونها به صورت فهرست وار در پنجره ها قرار ميگيرند.

Details: در اين روش آيكونها با تمامي جزييات مربوط به آنها نمايش داده ميشوند كه جزييات عبارتند از نام , نوع , اندازه ,و تاريخ نصب يا تاريخ تغيير آنها.

براي دسترسي به چهار نوع نمايش فوق به شيوه هاي زير ميتوان عمل كرد:

1. انتخاب يكي از روشهاي فوق با استفاده از منوي View .
2.  كليك چپ ماوس روي فلش ابزار View در نوار ابزار و انتخاب يكي از روشهاي فوق.
3.  كليك راست روي ناحيه اي خالي از پنجره و انتخاب يكي از روشهاي فوق از كادر ظاهر شده. 

شيوه هاي مختلف چيدن آيكونها در پنجره ها يا روي ميزكار ويندوز 98
ويندوز 98 ميتواند نشانه ها را به 5 روش در هر پنجره يا روي ميز كار آرايش دهد كه عبارتند از:

by Name: در اين روش آيكونها براساس حروف الفبا مرتب ميشوند.

by Type: در اين روش آيكونها بر اساس نوع يا پسوندشان مرتب ميشوند.

by Size: در اين روش آيكونها بر اساس اندازه اي كه حافظه را اشغال كرده اند مرتب ميشوند.

by Date: در اين روش آيكونها  بر اساس زمان نصبشان روي كامپيوتر مرتب ميشوند.

Auto Arrange: در اين روش آيكونها هميشه بطور اتوماتيك( بر اساس آخرين انتخابهاي بالا) مرتب ميشوند.

شيوه هاي دسترسي به اين نوع آرايشها عبارتند ار :

1.  صدور فرمان Arrange Icons از منوي View و انتخاب يكي از موارد فوق.
2. كليك راست روي ناحيه اي خالي از فضاي پنجره و صدور دستور Arrange Icons از كادر دستورات سپس انتخاب يكي از موارد فوق.

نحوه نمايش آيكونها در پنجره ها
در ويندوز 98 اين قابليت وجود دارد كه محتويات هر پنجره به شيوه هاي مختلفي نشان داده شود ، همچنين  ميتوان به ويندوز دستور داد كه آيا محتويات هر پوشه رادر پنجره اي جداگانه مربوط به خودش نشان دهد يا اينكه در همان پنجره قبلي آنرا نمايش دهد.

مراحل انجام عمل: 

1.  انتخاب منوي View
2.  صدور فرمان Folder Option
3.  انتخاب تب General 

در پنجره ظاهر شده سه نوع مختلف از شيوه هاي نمايش آيكونها در پنجره ها قابل دسترسي استكه عبارتند از: 

Web Style : آيكونها به شيوه متداول در صفحات وب (web) نشان داده شوند. 

Classic Style : آيكونها به شيوه كلاسيك و عادي ويندوز نشان داده شوند. 

Custom Style : آيكونها به شيوه هايي كه شخصا" براي ويندوز تعريف مي كنيم نمايش داده شوند. 

هر كدام از گزينه هاي فوق كه با كليك چپ بر روي آنها ميتوان آنها را فعال يا غير فعال نمود ، داراي دكمه اي به نام Setting سمت راست پايين پنجره هستند كه با كليك بر روي آن ميتوان براي هر كدام از روشهاي فوق تغييراتي را اعمال نمود اين تغييرات عبارتند از:

Active Desktop

 گزينه هاي ذيل را براي تغيير در نحوه نمايش ميز كار در اختيار ميگذارد . 

Enable all web- related content on my desktop : تمام خصوصيات و ارتباطاتي كه در صفحات وب وجود دارد براي ميز كار ويندوز در نظر گرفته ميشود.

Use windows classic desktop  : از حالت عادي ويندوز براي نمايش محتويات ميز كار استفاده ميشود. 

Browse folder as fallows

 پوشه ها مطابق يكي از حالتهاي ذيل نمايش داده شوند.

Open each folder in the same window: هر پوشه در همان پنجره اي كه پوشه هاي قبلي در آن باز شده اند نشان داده شود.

Open each folder in its own window : هر پوشه را در پنجره اي اختصاصي و مربوط به خودش باز كن.

View web content in folder

 ميتوان با انتخاب يكي از دو گزينه زير نمايش محتويات پوشه ها را به حالت و بي (web ) تبديل كرد.

For all folder with HTML content : براي همه پوشه هايي كه به صورت HTML طراحي شده اند حالت و بي (web )  نمايش داده شوند.

Only for folders where I select as web page (view menu) : فقط براي پوشه هاي كه من انتخاب ميكنم از حالت و بي (web ) براي پوشه ها استفاده كن .

Click Item as follows

 نحوه كليك كردن روي آيتمها ميتواند به يكي از حالتها زير صورت گيرد.

Single click to open an Item (point to select)  : به محض قرار گرفتن ماوس روي آيتمي آن آيتم انتخاب شود و يك بار كليك دكمه چپ ماوس باعث باز شدن يا اجرا شدن ايتم ها شود.

Double click to open an Item( single click to select ) :يك بار كليك دكمه چپ ماوس روي آيتمي باعث انتخاب آن آيتم شود و دو بار كليك دكمه چپ ماوس باعث باز شدن يا اجرا شدن آيتمها شود.

تنظيم  خصوصيات مربوط به سطل بازيافت ( Recycle Bin )

همانطور كه در قبل گفتيم كليك راست روي هر آيكون و انتخاب گزينه Properties  از كادر دستورات آن منجر به نمايش خصوصيات آن آيكون ميشود. بنابراين با انجام مراحل زير ميتوان خصوصيات سطل بازيافت را ظاهر ساخت:

1.  كليك راست روي آيكون سطل بازيافت
2.  انتخاب دستور Properties 

پنجره خصوصيات سطل بازيافت حداقل شامل يك تب به نام Global (سراسري) و يك تب به نام درايو   C ميباشد. اگر تب هاي ديگري را در پنجره مزبور مشاهده ميكنيد بدين دليل است كه ويندوز اين امكان را دارد كه خصوصيات سطل بازيافت براي هر درايو بطور مستقل تعريف شود. بنابراين به تعداد درايوهاي ايجاد شده روي كامپيوترتان ، تب مشاهده ميكنيد.

تب Global :

در اين تب ميتوان مشخص نمود كه آيا خصوصياتي كه براي سطل بازيافت در نظر ميگيريم براي همه درايوها يكسان باشد يا اينكه براي هر درايو متفاوت باشد . اين عمل با استفاده از گزينه هاي زير امكان پذير است :

configure drives Independently : با انتخاب اين گزينه خصوصيات سطل بازيافت براي هر درايو بطور جداگانه قابل تعريف است و يكسري گزينه هاي ديگر در اين پنجره را غير فعال ميكند. 

Use one setting for all drives :با انتخاب اين گزينه از يك خصوصيت مشترك براي تمام درايوها استفاده ميشود به عبارت ديگر خصوصيت سطل بازيافت براي تمام درايوها يكسان خواهد بود. 

تا اين قسمت براي سطل بازيافت تعريف كرده ايم كه آيا خصوصياتش در همه درايوها يكي باشد يا نه اما توسط گزينه هاي ذيل خصوصيات اصلي مربوط به خود سطل را تعريف مكنيم كه عبارتند از: 

Recycle Bin Do not move files to the:اگر اين گزينه انتخاب شود فايلهايي كه از روي كامپيوتر حذف ميشوند به داخل سطل بازيافت منتقل نميشوند بلكه مستقيما از حافظه سيستم حذف  خواهند شد و امكان بازگرداندن آنها وجود ندارد. ضمنا با انتخاب اين گزينه ساير گزينه ها در قسمت مربوطه غير فعال خواهند شد.  

Maximum size of Recycle Bin :در اين قسمت  نوار لغزاني قرار دارد كه با تنظيم آن مشخص ميكنيم چقدر از فضاي حافظه هر درايو براي سطل بازيافت كنار گذاشته شود.بطور پيش فرض ويندوز10 در صد از فضاي حافظه هر درايو را براي فايلهايي كه حذف ميشوند كنار ميگذارد  

در صورت لزوم ميتوان با تنظيم نوار لغزان اين فضا را بيشتر يا كمتر نمود.  

Display delete confirmation dialog box: با انتخاب اين گزينه ويندوز هنگام حذف فايلها كادري را ظاهر ميكند كه براى اطمينان بيشتر از شما سئوال مينمايد كه آيا هنوز مايل به حذف فايلها هستيد يا خير در صورت لزوم ميتوان پاسخ Yesيا No را كليك نمود. اگر اين گزينه از حالت انتخاب خارج شود كادر مزبور ظاهر نخواهد شد و ويندوز مستقيما فايلها را حذف خواهد نمود. 

  توضيح : تب هاي ديگري كه در اين پنجره مشاهده مي كنيد خصوصيات فوق را بطور جداگانه براي هر درايو تعريف خواهد نمود. 

نكته: براي انتخاب هر كدام از گزينه هاي فوق يك بار كليك چپ بر روي آنها باعث انتخاب گزينه مزبور خواهد شد همچنين يك بار كليك چپ بر روي گزينه اي كه انتخاب شده است آن را از حالت انتخاب خارج خواهد كرد.  

خالي نمودن محتويات سطل بازيافت(RecycleBin )

روش اول
1.  كليك راست روي آيكون سطل بازيافت.
2.  صدور دستورEmpty Recycle Bin .
3.     كليك روي دكمه Yes .

روش دوم
1.  با از كردن پنجره آيكون سطل بازيافت.
2.  انتخاب تمامي موارد داخل پنجره(يا موردهاي مورد نظر) ( Edit > Select All )
3.  صدور فرمان Delete .
4.  كليك روي دكمه Yes.

تنظيم خصوصيات مربوط به نوار وظيفه 

براي نوار وظيفه در ويندوز 98 ميتوانيم خصوصياتي تعريف كنيم و آن را مطابق سليقه شخصي خود آرايش دهيم . انجام اين كار مراحل ذيل را انجام دهيد:  

1.  كليك راست روي نوار وظيفه 
2.  انتخاب دستور Properties  

در پنجره باز شده روي صفحه كه بطور پيش فرض تبTaskbar آن فعال است چهار گزينه مشاهده مكنيد كه با انتخاب آنها ميتوان نوار وظيفه را  پيكر بندي نمود. توضيح اين چهار گزينه به قرار ذيل است :  

 Always on top : با انتخاب اين گزينه نوار وظيفه همواره روي پنجره هاي باز شده قرار خواهد گرفت.  

 Auto hide : با انتخاب اين گزينه نوار وظيفه بطور اتوماتيك پنهان يا آشكار خواهد شد بدين صورت كه ماوس را روي ناحيه اي كه نوار وظيفه قرار دارد بياوريم نوار ظاهر خواهد شد و به محض اينكه ماوس را به ناحيه اي بالاتر ببريم نوار ناپديد خواهد شد.  

 Show small Icons in Start Menu : با انتخاب اين گزينه آيكونهاي موجود در منوي شروع به صورت كوچك نمايش داده خواهند شد كه اين خاصيت باعث خواهد شد منوي شروع بتواند گزينه هاي بيشتري را در خود نمايش دهد.  

  Show clock: با انتخاب اين گزينه ساعت سيستم همواره سمت راست نوار وظيفه نشان داده خواهد شد.  

تنظيم نوار ابزارهاي نوار وظيفه(Taskbar)  

در ويندوز 98 ميتوان براي نوار وظيفه، نوار ابزارهايي در نظر گرفت كه قسمتهاي مختلفي را هميشه در اختيار ما بگذارد . براي تنظيم اين نوار ابزارها به شيوه ذيل عمل كنيد:  

1.  كليك راست روي نوار وظيفه
2.  انتخاب گزينه Toolbars از كادر دستورات
3.  انتخاب يكي از موارد ظاهر شده در منوي فوق 

توضيح گزينه هاي كادر فوق 

Desktop : باعث ظاهر شدن تمام آيكونهاي روي ميز كار در نوار وظيفه خواهد شد. 

Links : باعث ظاهر شدن تمام ارتباطات اينترنتي شما در نوار وظيفه خواهد شد. 

Address : باعث ظاهر شدن نوار آدرس در نوار وظيفه خواهد شد.  

My computer : باعث ظاهر شدن محتويات پنجره MY computer در نوار وظيفه خواهد شد.  

Quick Launch :باعث ظاهرشدن قسمتي در نوار وظيفه خواهد شد كه ميتوانShortcut ها را در آن قسمت قرار داد..  

توضيح : براي انتخاب هر كدام از گزينه هاي فوق يك بار كليك چپ روي آنها كافيست .لازم به ذكر است كه گزينه اي كه انتخاب شود كنار آن يك علامت چك مارك ظاهر خواهد شد. براي اينكه   گزينه اي را از حالت انتخاب خارج كنيم كافيست يك بار ديگر روي آن كليك كنيم.   

صفحه نمايش يا Display

آيكون فوق در ويندوز 98 براي تغيير و تنظيم كليه اعمال مربوط به رنگ پنجره ، اندازه و قلم آيكونها ، تعريف محافظ صفحه نمايش، تعريف پس زمينه، تعداد رنگ استفاده شده در مانيتور و وضوح تصاوير به كار ميرود.

نحوه باز كردن پنجره Display

روش اول:

My Computer > Control Panel > Display  

روش دوم:

كليك راست روي پس زمينه ويندوز در جايي خالي روي desktop  و انتخاب Properties  .

روش سوم:

Start > Setting > Control panel > Display

تبها يا كليدهايي انتخابي كه در قسمت مشخصات صفحه نمايش (properties) قرار دارند عبارتند از:

1.  تب Background

در اين تب امكان قرار دادن طرح يا تصوير يا الگويي روي پس زمينه ويندوز وجود دارد.

توضيح گزينه ها:
Wallpaper : كاغذ ديواري يا طرح مورد نظر را از بين گزينه هاي كادر آن ميتوان انتخاب نمود.

Pattern : دكمه اي است كه با كليك بر روي آن اجازه ميدهد الگويي را از بين گزينه هاي آن روي پس زمينه قرار داد.

Browse : دكمه اي است كه از آن براي قرار دادن تصويري روي پس زمينه از درون فايلها و درايوهاي كامپيو تر مان استفاده ميشود.

2.  تب Screen Saver

امكان فعال ساختن محافظ صفحه نمايش را روي مانيتور امكان پذير ميسازد.

نكته: چون اشعه كاتدي بطور مستقيم به صفحه نمايش تابيده مي شود و اگر كامپيوتر فعال نباشد اين اشعه مستقيما" به يك قسمت ثابت صفحه برخورد كرده و باعث لكه دار شدن آن قسمت از صفحه نمايش مي گردد لذا با گذاشتن محافظ صفحه (Screen Saver ) باعث مي شويم مدتي كه كامپيوتر ما كار نمي كند در لحظه تائين شده محافظ صفحه فعال شده و دستگاه ما را فعال نمايش دهد و اشعه ها پراكنده تابيده شوند.)

   توضيح گزينه ها:
Screen Saver: امكان تعريف و انتخاب محافظ مورد نظر را از طريق گزينه هاي اين كادر امكان پذير است.

Wait: مشخص ميكند تا چه زماني اگر كليدي فشرده نشد يا ماوس حركت نكرد (كا مپيوتر به حالت روشن بي كار بماند) محافظ فعال شود.

Setting:براي تغيير دادن خصوصيات محافظ ها مانند سرعت حركت روي صفحه ، بزرگي يا كوچكي اندازه محافظ و وضوح محافظ استفاده ميشود.(در قسمت انتخابي ( 3D Text)مي توانيد متن(نام خودتان و...) را وارد نماييد و به آن جلوه ويژه اي دهيد)

Preview: امكان ديدن محافظ قبل از كاربرد آ ن را ميسر ميسازد.

Password Protected: امكان رمز گذاري روي محافظ را ميسر ميسازد كه در اين صورت اگر محافظ فعال شود براي برگشت به محيط كار بايد حتما رمز مورد نظر را در كادر مربوطه وارد كرد.

توضيح: با فعال كردن گزينه فوق دكمه Change فعال شده با كليك روي آن پنجره اي باز ميشود كه امكان تعريف رمز را ممكن ميسازد.

نكته1: چون رمز گذاري عمل مهمي است بايد دو بار رمز را وارد كرد.

نكته2: اگر رمز خود را فراموش كنيم هيچ راهي براي برگشت وجود ندارد.

3.  تب Appearance

امكان تغيير دادن و تنظيم رنگ اجزاي صفحه نمايش ويندوز را در اختيار ميگذارد. پنجره ها
توضيح گزينه ها:
Scheme: نماي خاصي را براي اعمال كلي به تمام قسمتهاي صفحه از بين گزينه هاي كادر خودش ممكن ميسازد.

Item : امكان تغيير رنگ يا تغيير قلم و كارهاي ديگري را براي اعمال  در جز. به جز. قسمتهاي صفحه ميسر ميسازد.

نكته: در صورتيكه نماي انتخابي مورد پسند نبود از بين گزينه هاي كادرScheme گزينه حالت استاندارد ويندوز Windows Standardرا انتخاب كنيد تا نماي صفحه به حالت اصلي خود باز گردد.

4.  تب effects  جلوه هاي ويژه
شما در اين قسمت مي توانيد از جلوه هاي خاص و ويژه (تغيير بزرگي و كوچكي  شمايل يا آيكونها و...) تغيير شكل يا مخفي نمودن آيكونها استفاده نماييد.

5.  تب web نمايش صفحه نمايش بصورت web 

در اين تب شما مي توانيد با انتخاب حالت و بي ( web) ميز كار و صفحه نمايشتان را مانند صفحات اينترنتي نموده و بتوانيد صفحات دلخواه اينترنتتان را در روي ميز كار داشته باشيد.

6- تب Setting  

امكان تغيير در وضوح تصاوير و تعداد رنگ بكار رفته براي ساخت تصاوير در مانيتور را ميسر ميسازد.

توضيح گزينه ها: 

Colors : توسط آن ميتوان مشخص كرد كه سيستم از چه تعداد رنگي براي ساختن  تصاوير  استفاده ميكند.

Screen Area : امكان تغيير در وضوح تصاوير را ميسر ميسازد . براي تغيير آن بايد دكمه چپ ماوس را روي نوار لغزان گرفته و نگه داشت و ماوس را به طرف چپ يا راست جابجا كرد.

نكته1: وضوح تصاوير با تعداد رنگ بكار رفته در آنها در ارتباط است ، اگر وضوح بيش از حد زياد شود تعداد رنگ كم ميشود و بالعكس.

نكته2: بعد از انجام هر مرحله در هر تب ، كليك نمودن روي دكمهApply يا OK ضروري است.

نكته3: تفاوت دكمه Apply با OK در اين است كه كليك روي دكمه Apply تغييرات را اعمال كرده  ولي پنجره مزبور را نمي بندد ولي OK  تغييرات را اعمال كرده و پنجره مزبور  را ميبندد.

توضيح در مورد پنجره Mouse و گزينه هاي آن
از اين آيكون در مركز كنترل ويندوز براي تغيير مشخصه هاي ماوس استفاده ميشود.

Start > Settings > Control Panel >Mouse

7- تب Buttons

در اين تب امكان تغيير عملكرد دكمه هاي ماوس براي افراد راست دست و چپ دست وجود دارد كه با كليك چپ روي هر يك از دو گزينه زير ميسر ميشود.

Left Hand : افراد چپ دست
Right Hand : افراد راست دست
8- تب Pointers

در اين تب امكان ديدن و تغيير دادن اشكال مختلف ماوس براي كاربرد هاي مختلف وجود دارد همچنين ميتوان نماي خاصي را براي حالتهاي مختلف ماوس از طريق كادر Schemeتعريف كرد.

9- تبMotion 

در اين تب امكان تغيير سرعت حركت ماوس و ديدن مسير حركت  ماوس امكان پذير است .

Pointer Speed : امكان تغيير در سرعت حركت ماوس توسط اين قسمت امكان پذير است .براي تغيير  آن بايد دكمه چپ ماوس را روي نوار لغزان گرفته و نگه داشت و ماوس را به طرف چپ يا راست جابجا نمود.

Pointer trail : امكان ديدن مسير حركتي ماوس به صورت طولاني يا كوتاه امكان دارد . براي تغيير آن بايد دكمه چپ ماوس را روي نوار لغزان گرفته و نگه داشت و ماوس را به طرف چپ يا راست جابجا نمود.

جستجو در ويندوز 98 (Find)

اگر بنا به دلايلي احتياج به دسترسي به فايل خاصي داريم اما نام كامل فايل يا قسمتي از نام آن را فراموش كرده ايم ميتوانيم از دستور Find در محيط ويندوز 98 براي پيدا كردن فايل مورد نظر خود استفاده كنيم . ويندوز 98 امكان جستجوي فايلهاي مورد نظر ما را با قابليتهاي زير امكان پذير ميسازد:

جستجو بر اساس نام و محل قرار گرفتن فايلها.
جستجو بر اساس نوع فايلها.
جستجو بر اساس حجم اشغال شده توسط فايلها.

شيوه هاي دسترسي به دستور Find

روش اول
1.  باز كردن منوي Start
2.  انتخاب منوي Find
3.  انتخاب گزينه Files or Folder 

روش دوم
1.  كليك راست روي منوي Start
2.  انتخاب دستور Find از كادر ظاهر شده. 

نكته: با كليك راست روي آيكون هر پوشه يا فايل و انتخاب دستور Find از كادر دستورات ظاهر شده نيز ميتوان دستور جستجو را صادر كرد.

با نگاهي به پنجره دستور Find متوجه مي شويم كه سه تب مختلف امكان جستجو بر اساس معيارهاي مختلف را ميسر ميسازد.در ذيل به توضيح اين سه تب ميپردازيم.

تب Name & Location :

اين تب شامل دو كادر ويرايشي و يك كادر Look in ميباشد. لازم به ذكر است كه وجود كادر Look in در هر پنجره اي امكان ديدن محتويات درايوها ي مختلف و انتخاب هر كدام از درايوها را امكان ميسازد.

  كادر ويرايشي Name :

اگر بخواهيم بر اساس نام فايل عمل جستجو انجام گيرد نام فايل مورد نظر را در كادر ويرايشي مذكور وارد ميكنيم .ذكر اين نكته ضروري است كه اگر قسمتي از نام يا پسوند فايل مورد نظر را فراموش كرده باشيم ميتوانيم از كاراكترهاي جانشين (علامت  * يا ?) استفاده ميكنيم.

كادر ويرايش Containing Text :

اين كادر قابليت جستجو بر اساس محتويات فايلها را فراهم مي آورد بدين صورت كه عبارت مورد نظري را كه ميخواهيم ويندوز آن را در تمامي فايلها جستجو كند در اين كادر وارد ميكنيم.

كادر Look in :

اين كادر محل جستجو را براي ويندوز مشخص ميكند. قابليتي كه در ويندوز 98 اضافه شده است امكان جستجوي فايل را همزمان در درايوهاي مختلف ( با استفاده از گزينه My computer) ميسر ميسازد. با استفاده از فلش سمت راست اين كادر ميتوانيم محل جستجو را از ميان گزينه هاي آن براي ويندوز مشخص كنيم .

پس از تنظيم كادرهاي فوق دكمه Find Now يا New Search را كليك ميكنيم تا عمل جستجو شروع شود.

تب Date :

در اين تب ميتوانيم فايلهايي را كه در يك فاصله زماني مشخص تغيير پيدا كرده اند  يا اينكه ا يجاد شده اند و يا براي آخرين مرتبه مورد دستيابي قرار گرفته اند ، جستجو كنيم.

كادر Find All Files :

با كليك روي اين گزينه و استفاده از فلش سمت راست آن ميتوانيم يكي از گزينه هاي ذيل را براي عمل جستجو مشخص كنيم :… فايلهايي كه بين تاريخهاي انتخاب شده دچار تغيير شده اند مورد جستجو قرار ميگيرند.

Modified : فايلهايي كه بين تاريخهاي انتخاب شده ايجاد شده اند مورد جستجو قرار ميگيرند.

Created : فايلهايي كه بين تاريخهاي انتخاب شده، آخرين مرتبه از آنها استفاده شده است مورد جستجو قرار ميگيرند.

پس از مشخص شدن معيار جستجو ، با كليك روي گزينه Between و همچنين مشخص نمودن فاصله زماني مورد نظر با استفاده از دو كادر در نظر گرفته شده براي اين كار ، عمل جستجو با كليك بر روي دكمه Find Now صورت ميگيرد.

همچنين با كليك بر روي هر يك از دو گزينه  During the Previous ميتوان عمل جستجو را بين چند روز  قبل از تاريخ فعلي محدود نمود.

( During the previous  Months) طي ماه هاي گذشته.

( During the previous  Days) طي روزهاي گذشته.

تب Advance :

در اين تب امكان جستجوي فايلها بر اساس نوع يا اندازه آنها ممكن است .

Of type : با كليك روي اين گزينه و كليك بر روي فلش سمت راست آن، امكان جستجو فايلها بر اساس پسوند آنها ميسر ميشود مثلا ميتوان عمل جستجو را به فايلها با پسوند Wav كه مختص فايلهايي صوتي ويندوز است محدود نمود.

Size in : با كليك بر روي آن ميتوانيم عمل جستجو را به اندازه فايلها وابسته كنيم بدين ترتيب كه عمل جستجو روي فايلهايي با اندازه مورد نظر صورت پذيرد . اين گزينه شامل دو امكان براي عمل جستجو است به قرار ذيل:

At Least : حداقل اندازه فايل 

At Most : حداكثر اندازه فايل
پس از  مشخص نمودن يكي از دوگزنيه فوق در كادر مقابل آن اندازه مورد نظر خود  را براي عمل جستجو بر حسب واحد كيلو بايت وارد ميكنيم . به عنوان مثال با انتخاب گزينه At Least و وارد نمودن عدد 100 كيلو بايت است محدود ميشود به عبارت ديگر فايلهايي كه حجم آنها بالاتر از 100 كيلو بايت است مورد جستجو قرار ميگيرد.

درايوها در ويندوز98
نحوه مشاهده خصوصيات مربوط به يك درايو 

براي ديدن خصوصيات هر كدام از درايوهاي كامپيوتر خود در ويندوز 98 مراحل زير را انجام دهيد: 

1.  كليك راست روي آيكون درايو مورد نظر 
2.  انتخاب دستور Properties    

در پنجره ظاهر شده روي صفحه تمام خصوصيات درايو مورد نظر قابل رويت است ،اين خصوصيات عبارتند از :  

Label : بر چسب يا نام كه براي هر درايو ممكن است مشخص كنيم در اين كادر قابل تغيير، ايجاد و يا حذف ميباشد.  

Type: مشخص ميكند كه آيا درايو شما مربوط به كامپيوتر خود شماست و يا اينكه به صورت اشتراكي در اختيار شما قرار دارد.( حالت اشتراكي بيشتر براي شبكه هاي كامپيوتري تعريف ميشود).

Used space : فضاي خالي در هر درايو از كامپيو تر را با رنگ صورتي نشان ميدهد.مقدار عددي فضاي مورد نظر مقابل گزينه فوق قابل رويت ميباشد
Free space : فضاي استفاده شده توسط برنامه هاي نصب شده يا كپي شده در هر درايو از كامپيوتر را با رنگ  آبي نشان ميدهد . مقدار عددي فضاي اشغال شده مقابل گزينه فوق  قابل  رويت ميباشد.

Capacity:مجموع فضايي كه براي هر درايو از كامپيوتر در نظر گرفته شده است را به صورت عددي پايين دو گزينه فوق نشان ميدهد.

نحوه انجام قالب بندي ( Format ) و كپي كردن فلاپي ديسكها در ويندوز 98
بر روي هر فلاپي ديسك  ميتوان اعمالي از قبيل فرمت كردن و يا ديسك كپي  كردن را انجام داد،براي دستيابي به دستورات مربوط به انجام اين كارها مراحل زير را انجام دهيد:

تذکر مهم:
 اگر درايو يا ديسكتي را فرمت نمائيد،تمامي فايلهاي آن پاك شده و فايلها و پوشه هاي حذف شده قابل برگشت نيستند.لذا هيچ وقت اين عمل را بدون آگاهي كامل يا تسلط به اين امر انجام ندهيد.)

فرمت كردن ديسكت ها
1.  ديسك را داخل درايو قرار دهيد.
2. بر روي آيكون درايو A در پنجره My computer كليك راست كنيد.
3.  دستور Format را از كادر دستورات ظاهر شده انتخاب كنيد.

با انجام كارهاي فوق، پنجره اي باز خواهد شد كه امكان عمل فرمت را در اختيار خواهد گذاشت. توضيح گزينه هاي پنجره فوق به شرح ذيل است:

Quick Format فرمت سريع) : انتخاب اين گزينه  امكان انجام فرمت سريع را ميسر خواهد ساخت. در اين حالت عمل فرمت كردن فقط اطلاعات روي ديسكت را حذف ميكند بنابراين سرعت انجام عمل بالاست.

Full Formatفرمت كامل): انتخاب اين گزينه امكان انجام عمل فرمت كامل را ميسر خواهد ساخت . در اين حالت ديسكت يك بار ديگر از ابتدا فرمت خواهد شد يعني هم اطلاعات روي آن از بين خواهد رفت و هم از نو فرمت ( قالب بندي) ميشود.

Copy system files only : انتخاب اين گزينه فقط امكان كپي كردن فايلهاي سيستمي را روي ديسكت ميسر ميسازد ( نه تنها ديسك را فرمت نميكند بلكه اطلاعت روي آن را نيز حذف نمي نمايد) به عبارت ديگر ديسكت را به يك ديسكت راه انداز تبديل ميكند.

Label :امكان تعريف يك بر چسب (نام) را براي ديسك ميسر ميسازد.

No Label : با انتخاب اين گزينه به ويندوز ميگويم مايل به ايجاد هيچ بر چسبي براي ديسك نيستيم.

display summary when finished :اگر اين گزينه انتخاب شود پس از عمل فرمت خلاصه اي از اعمال انجام شده بر روي ديسك توسط ويندوز نمايش داده خواهد شد.

Copy system files: انتخاب اين گزينه در صورتي معنا دارد كه يكي از گزينه هاي فرمت سريع يا فرمت كامل انتخاب شده باشد،در اين صورت ويندوز پس از انجام عمل فرمت فايلهاي سيستمي را نيز بر روي ديسك كپي مينمايد.( به عبارت ديگر ديسك پس از فرمت شدن به يك ديسك راه انداز تبديل خواهد شد).

پس از تنظيم گزينه هاي مورد نظر بر روي دكمه  Startكليك كنيد تا عمل فرمت آغاز شود.

Disk copy   ديسك كپي كردن فلاپي ديسكها.

يكي ديگر از كارهايي كه روي ديسك ها قابل انجام است ديسك كپي كردن آنها ميباشد. ديسك كپي يعني اينكه تمام اطلاعات روي يك ديسك را بر روي ديسكت ديگري كپي نماييم . مثلا اطلاعات روي فلاپي ديسك A را بر روي فلاپي ديسك A ديگري كپي نماييم . نحوه انجام عمل به ترتيب ذيل است:

1.  كليك راست روي آيكون درايوA
2.  انتخاب دستور Copy disk

با انجام اعمال فوق پنجره اي ظاهر خواهد شد  كه داراي دو گزينه است:

Copy from: مبدا عمل ديسك كپي را مشخص ميكند كه بطور پيش فرض ديسك با ظرفيت 44/1 ميباشد.

Copy to : مقصد انجام عمل ديسك كپي را مشخص ميكند كه بطور پيش فرض ديسك با ظرفيت 44/1 ميباشد
با كليك روي دكمه Start عمل ديسك كپي شروع خواهد شد و به شما پيغام خواهد داد كه ديسك مبدا را داخل درايو قرار داده و كليدي را فشار دهيد و پس از اتمام عمليات روي  ديسك مبدا از شما خواسته ميشود كه ديسك مقصد را داخل  درايو قرار داده و كليدي را فشار دهيد.

كار كردن با پنجره Internet explorer 

پنجره اينترنت يا Internet explorer نيز دقيقا" عين پنجره My Documents كه در بالا مفصلا" توضيح داديم بوده وبراي كار با قسمتهاي مختلف آن اگر اشكالي داشتيد حتما" مطالب مربوط به مشخصات و امكانات يك پنجره را مجددا" مرور نماييد. ما در اين قسمت فقط به نحوه استفاده عملي كه بيشتر مربوط به Tool bar خواهد بود را بيان مىكنيم وكمى هم ابزارهاى مهم و مورد نياز Menu bar را كه در نوار ابزار قرار ندارند را توضيح خواهيم داد. 

تذكر:  جهت اتصال به اينترنت شما بايست حتما" از يك شركتي Account داشته و با وارد نمودن نام كاربر ، رمز ورود يا شناسايى و شماره تلفن شركت مربوطه از طريق dial up networking ( كه در Start>Programs>Accessories>Communications>Dial up Networking قرار دارد) ابتدا به شبكه وصل شويد و بعد از اتصال به شبكه مىتوانيد با كليك روي Internet explorer سراغ صفحات اينترنت برويد ولي اگر در شركت ،سازمان و موسسه اي ميباشيد كه درون شبكه قرار دارد و شبكه به اينترنت وصل است شما كافي است مستقيما" روي Icon اينترنت كليك كرده و به اينترنت وصل شويد. 

هنگاميكه شما روي Internet explorer كليك كرده و به اينترنت وصل شديد احتمالا" با سه نوع صفحه مواجه شويد. 

1. صفحه اي خالي كه در روي نوار آدرس نيز نوشته شده است about: blank كه در اين حالت شما روي نوار آدرس كليك نموده و آدرس سايت مورد نظر مثلا" www.sharif.ac.ir يا www.yahoo.com را نوشته و كليد Enter را فشار داده و يا روي دكمه Go كه در جلوي نوار آدرس است كليك نماييد. و آنوقت محتويات صفحه عوض شده و صفحات home page آن آدرس آرام آرام download شده و صفحه تكميل مىشود. 

چند تذ كر:
· · نسبت به حجم،گرافيك،انيميشن و عكسهاي موجود دريك صفحه در مقايسه با صفحات ديگر احتمال دارد تا بطور كامل تكميل و download شدن يك صفحه كمي زياد طول بكشد و بايستي منتظر شد و اگر صفحه تكميل شود انتقال مطالب قطع شود شما كلمه Done به معني تكميل و پايان (انجام گرفته ) را در گوشه پايين سمت چپ نوار وظيه يا status bar مشاهده خواهيد نمود.

· · چند چيز نشانگر انتقال اطلاعات و اتصال شما به شبكه يا اصطلاح" زنده بودن اينترنت شما را نشان مي دهد.هنگاميكه شما به صفحه اي وارد مىشود اولا" شكل كره كوچكي كه در بالاي( گوشه سمت راست ) نوار فهرست يا menu bar قرار دارد شروع به چرخيدن مي نماييد. ضمنا" هنگاميكه نشانگر ماوس شما روي نوار فهرست قرا گيرد تبديل به يك ساعت شني شكل كه نشانگر فعال بودن صفحه است مىشود و همچنين اگر به نوار وضعيت توجه كنيد متوجه دو نكته خواهيد شد كه اولا" روي نوار وضعيت آدرس و نوع فايلها و محتويات در حال انتقال تند تند در گوشه سمت چپ نوار نوشته مىشود و همچنين يك نوار آبي رنگي در حال پر شدن يا تكميل مىباشد وبه محض اتمام عمليات اين چهار نشانه از كار افتاده و درگوشه سمت چپ نوار ابزار كلمه اتمام يا Done درج مىشود. 

2)احتمال دارد صفحه اي بدين مضمون پيدا شود كه نشانگر عدم اتصال به شبكه بوده و شما بايستي آنرا چك نوده و از اتصال به شبكه مطمئن باشيد. 

	
	Action canceled 

	Internet Explorer was unable to link to the Web page you requested. The page might be temporarily unavailable. 

	

Please try the following: 

Click the Refresh button, or try again later. 

If you have visited this page previously and you want to view what has been stored on your computer, click File, and then click Work Offline. 

For information about offline browsing with Internet Explorer, click the Help menu, and then click Contents and Index. 

Internet Explorer 


3) امكان دارد صفحه شما يك صفحه اي را كه صفحه اصلي و اوليه يا Home ناميده مىشود را بياورد كه معمولا" صفحه مايكروسافت ( http://www.msn.com ) مىباشد. 

اين صفحه ورودي اوليه قابل تنظيم و تغيير مىباشد و شما مىتوانيد جهت تسهيل دركارها آنرا طوري تنظيم نماييد كه هميشه در ابتداي اتصال به شبكه صفحه دلخواه شما را ابتدا بياورد جهت اين امر روي نوار ابزار روي دكمه tools كليك نموده و گزينه Internet options را انتخاب نماييد (البته در Internet browse 5 به بالا در اين قسمت است شايد براي شما در روي دكمه View باشد ) ، پنجره اي باز مىشود كه شما مىتوانيد در قسمت Address آدرس سايت مورد نظر را نوشته و دكمه Apply يا Ok را كليك نماييد.و از اين به بعد اين صفحه ، صفحه Home شما خواهد شد. 

تذكر: در زير آدرس در قسمت General پنجره Internet options سه دكمه وجود دارد كه اولي (صفحه فعال و جارى الان را در آن قرار داريم مد نظر بگير.) Use current هنگامي كه ما روي صفحه مورد نظر رفته و اكنون آن صفحه در روي پنجره اينترنت فعال باشد اين دكمه را زده و سپس دكمه Apply يا Ok را كليك نماييم صفحه مورد نظر صفحه Home ما خواهد شد.
دكمه دومي يعني Use default همان صفحه پيش فرض كه صفحه مايكروسافت است را قرار مىدهد.
دكمه سومي كه Use blank بوده و يك صفحه خالي ارائه مىدهد كه شما آدرس را خودتان وارد نماييد. 

بهر حال وقتي صفحه اي آمد و شما مشاهده نموديد كار آغاز ميشود. اگر شما اشاره گر ماوس را روي صفحه ببريد مشاهده مىكنيد كه در روي بعضي نوشته ها( كه معمولا" آبي رنگ يا زير خط دار مىباشند ) و يا روي عكسها اشاره گر تبديل به يك دست مىشود (كه اصطلاحا" به آنها Link (اتصال به صفحات مربوط به آن موضوع ) گفته مىشود ). اين نشانه آن است كه جهت گرفتن اطلاعات و مطالب مورد نظر در رابطه با اين موضوع شما بايستي وارد صفحه اي ديگر شويد و كافي است روي آن قسمتي كه اشاره گر دست شده و مورد نظر شماست يك بار كليك نماييد و صفحه شما بزودي باز خواهد شد. 

تذكر:
 · · در اينترنت فقط يك كليك كافي است و به هيچوجه دوبار كليك ننماييد. 

· · دقت نماييد كه اگر روي Link ي در صفحه اي كليك نماييد احتمالا" صفحه جديد جايگزين صفحه قبلي خواهد گرديد وصفحه مقابل شما پاك شده و صفحه جديد جايگزين آن خواهد شد و اگر شما مىخواهيد آن Link در صفحه جداگانه اي باز شود و صفحه اصلي شما نيز به همان نحو باقي بماند تا مطالعه نماييد كافي است روي Link مورد نظر كليك راست نماييد كه گزينه هاى باز مىشود و شما گزينه دوم كه open in new window مىباشد را انتخاب نماييد تا صفحه مورد نظر شما را درصفحه اي غير از صفحه اصلي و بطور جداگانه در صفحه اى جديد باز شود. 

· · اما اگر شما نياز داريد كه اين صفحه فعال باشد ومىخواهد صفحه جديدي كه به اين صفحه ربطي ندارد ( اتصال يا Link ي در اين صفحه ندارد.)و داراي آدرس جداگانه اي است را نيز بطور جدا باز كنيد از سه روش زير مىتوانيد استفاده نماييد. 

1 ) صفحه فعال را Minimize نموده و دوباره روي Icon برنامه Internet explorer كليك نموده و آدرس مورد نظر را در قسمت آدرس روي صفحه جديد نوشته و كليد Go يا Enter بزنيد. 

2 ) در حاليكه صفحه شما فعال است دو كليد تركيب Ctrl+N را باهم فشار دهيد كه يك صفحه عين صفحه فعال شما باز خواهد نمود و شما با كليك روي آدرس و نوشتن آدرس جديد اين صفحه را به آدرس جديد راهنمايي نماييد. 

3 ) مىتوانيد روي صفحه فعال به قسمت نوار فهرست رفته ، روي دكمه File كليك نموده و گزينه New (Window) را انتخاب نماييد كه مانند مرحله قبل يك صفحه جديد باز مىنماييد و شما با كليك روي آدرس و نوشتن آدرس جديد اين صفحه را به آدرس جديد راهنمايي نماييد. 

شما براي مطالعه صفحات بلندي كه در يك صفحه قرار نمىگيرند مىتوانيد از دكمه هاي Text editing keys (Arrow keys) يا كليدهاي ويرايشي موجود روي صفحه كليد استفا د ه نماييد و يا با ماوس از قسمت Scroll bar كه قبلا" نحوه استفاده از آنها توضيح داده شده است استفاده نماييد و خط به خط يا صفحه به صفحه مطالب مورد نظررا مشاهده و مطالعه نماييد. 

با تشکر از استاد عزیزم ،آقای ظهیری
